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To use Studio Manager, you must follow these steps:
> Start Studio Manager.
> Configure the Editor.
> Synchronize Studio Manager.

Starting and Setting Up Studio Manager
Start Studio Manager.
Windows 2000: Click the Start button, move the cursor to [Programs], then [YAMAHA Studio
Manager], then click [Studio Manager].
Windows XP: Click the Start button, move the cursor to [All Programs], then [YAMAHA
Studio Manager], then click [Studio Manager].
Mac OS X: Select [Applications], [YAMAHA], then [Studio Manager], then double-click [Studio Manager].

2

Select the device you want to edit.
The names of all installed devices are displayed in the
Device Editor section. Select the desired device, the click
the [Add ->] button.
The selected device name appears in the Workspace section.
Note: If you plan to use the same device in the future, click
the [Set Default] button while the appropriate device name
is listed in the Workspace section. The next time you start
Studio Manager, the device will be automatically selected.
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Specify a MIDI port.
Select the [MIDI Ports] tab and specify the MIDI In, Out,
and Thru ports to which the console is connected.
Note: To activate a MIDI port in Studio Manager, you must
also specify the MIDI port in the console’s Editor separately.
Refer to the “Configuring the Editor” on page 4 described
later for information on specifying a MIDI port in Editor.

Studio Manager for V2 02R96 Editor—Owner’s Manual

Getting Started
Index

1

Using
UsingStudio
SM Windows
Manager
Windows

Description of menus and buttons

In the event that menu and button names on the Windows system are different from those on
the Macintosh system, this manual uses the Windows menu and button names followed by the
Macintosh menu and button names in parentheses.

Keyboard Shortcuts

Getting Started
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Getting Started

Click [OK].
The Studio Manager host window is displayed.

Studio Manager host window
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Double-click the icon of the console you want to edit.
The Editor for the console is displayed.

Quitting Studio Manager
Choose [Exit (Quit)] from the [File] menu in the host window.
If there are no unsaved changes, all windows close and Studio Manager quits. If there are unsaved
changes, a message asking whether or not you want to save the changes appears. Click [Yes] to save
the changes and quit, click [No] to quit, or click [Cancel] to cancel the operation. You can also quit
Studio Manager by clicking the host window’s Close button.
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Configuring the Editor
You must configure the following settings for each open Editor.
Note: Specify a MIDI port (page 2) before making the following settings.

System Setup

Windows System Setup window

Keyboard Shortcuts
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To open the Setup window, choose [System Setup] from the [File] menu.
Be sure to specify the Input port and Output port.

Macintosh System Setup window

Input port/Output port: These pop-up menus are used to select the ports through which
Studio Manager will communicate with your Yamaha mixing console.

Console Device ID: Studio Manager can control any one of up to eight Yamaha mixing consoles, each with its own exclusive ID. Select the ID of the console you want to control.
Channel Select: These options determine whether or not channel selection is linked. When the
PC->Console option is on, selecting a channel in Studio Manager selects the same channel on the
console. When the Console->PC option is on, selecting a channel on the console selects the same
channel in Studio Manager.
Confirmation: These options determine whether or not a confirmation dialog box appears
when storing, recalling, or patching.
Layer Select: These options determine whether or not Layer selection is linked. When the
PC->Console option is on, selecting a Layer in Studio Manager selects the same Layer on the console. When the Console->PC option is on, selecting a Layer on the console selects the same Layer
in Studio Manager.
Window Control from Console: This option determines whether or not using the USER
DEFINED KEYS on the console enables you to remotely open and close the Studio Manager windows.
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To open the Console Setup window, choose [Console Setup] from the [File] menu.

02R96 Editor window

Index

Keyboard Shortcuts

Surround Mode: Select a Surround mode from STEREO, 3-1, 5.1, and 6.1.
Pair Mode: These options determine whether the fader pair is Horizontal or Vertical.
Channel Copy Parameter: Select desired parameters to copy from channel to channel.
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Select whether you want to transfer your settings to Studio Manager, or vice versa.
To Hardware: Transfers the settings of the current Studio Manager Session to your console.
From Hardware: Transfers the settings of your console to the current Studio Manager Session.

3

Click [OK].
Do not operate the console while synchronization is in progress.
Note:
• You can synchronize the system for each Editor by choosing [Re-synchronize] from the [Synchronization] menu of each Editor. At this time, the All Lib option determines whether or not
Scene and Library data is synchronized. If you synchronize the system from the host window,
Scene and Library data will always be synchronized.
• To protect any communication ports that are used with Studio Manager, synchronizing Studio
Manager by selecting the To Hardware option does not affect any communication settings on
the console (such as the MIDI, Remote Layers, and Machine Control settings).

Offline Edit Function
If you do not want to synchronize your console with Studio Manager, select [Offline Edit] from the
[Synchronization] menu of each editor. To apply your off-line edits to your console, synchronize
the console with Studio Manager by selecting the To Hardware option.
The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the
Master window.
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When Studio Manager starts up, the parameter settings on the console and the parameter settings
in Studio Manager may be different. Therefore, you must first match the parameter settings on the
console with those in Studio Manager. This operation is called “synchronization.” Follow the steps
below to synchronize Studio Manager.
Select [Synchronize], then [Total Recall...] in the host window.
The following window opens.

Getting Started

Synchronizing Studio Manager

Opening a previously saved Session

Choose [Open (Session)] from the [File] menu.

Saving the current Session

Choose [Save (Session)] from the [File] menu.

Saving the current Session with a new name

Choose [Save (Session)] As from the [File] menu.

Note: In order to save the current Automix, or the settings of an optional Y56K card, in a Session, you
must first resynchronize Studio Manager by selecting the From Hardware option.
If you save a Session in the host window, all selected Editor settings are saved in a file with a file
extension of “.YSM.”
If you save a Session in an Editor, only that Editor’s settings are saved in a file.
The Editor’s settings are saved in either the Studio Manager V2 format (file extension “.YSE”) or a
format that is compatible with earlier versions of Studio Manager (file extension varies depending
on the console you are using).
Note that earlier versions of Studio Manager cannot open a Session saved in the “.YSE” format.
Note:
• If you try to create a new session in the host window or open a saved session, a message asking
whether or not you want to save the currently-open session appears. Click [Yes] to save the current
session and open the new or saved session. Click [No] to open the new or saved session without
saving the current session. Click [Cancel] to cancel the operation.
• Studio Manager may be unable to open some files stored in SmartMedia. In this case, copy those
files onto a hard disk, then try to open them in Studio Manager.

Undo/Redo Function
In Studio Manager, you can cancel the latest operation (Undo) and also cancel the cancellation of
the latest operation (Redo). If you perform an Undo operation twice in a row, you can cancel the
two most-recent operations. If you perform an Undo operation three times in a row, you can cancel the three most-recent operations. In this way, you can cancel multiple recent operations. The
following table describes how to use the Undo/Redo function.
Undo

Choose [Undo] from the [Edit] menu.

Redo

Choose [Redo] from the [Edit] menu.

Please note, however, that after you perform one of the following operations, you cannot successfully undo or redo any previous operation:
• Closing Studio Manager
• Changing Surround mode (Stereo/3-1/5.1/6.1)
• Changing Pair mode (Horizontal/vertical)
• Synchronizing the console with Studio Manager
• Creating a new Session
• Saving a Session
• Copying and pasting a channel
• Creating or cancelling a channel pair
• Storing or recalling a scene or library
• Turning on or off the GATE: [LINK] button in the Selected Channel window
• Turning on or off the COMPRESSOR: [LINK] button in the Selected Channel window
• Turning on or off the [LINK] button in the Surround Editor window
Studio Manager for V2 02R96 Editor—Owner’s Manual
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Choose [New (Session)] from the [File] menu.

Keyboard Shortcuts

Creating a new Session

Index

All of your Yamaha mixing console’s mix settings in Studio Manager, including Scene and library
data, are called Sessions. The following table describes how to handle Sessions.

Getting Started

Working with Sessions

Getting Started

Changing Aux Send mode (Fixed/variable) on the console
Starting automix recording or playback on the console
Changing the sampling frequency (operated on the device)
Changing the User Assignable Layer settings (operated on the device)
Note: You cannot Undo or Redo the following operations:
• Edits in the Setup window
• Synchronization
• Opening and closing the windows
• Resizing the windows
Note: In the Library window, you can Undo or Redo only the most recent operation. You cannot cancel
the preceding operations.

Other Functions
Copy & Paste Function

Keyboard Shortcuts

You can copy and paste not only the characters but the control positions in Studio Manager.
In the Console Setup window (page 5), you can also specify the parameters to be copied.

Select copy source characters, right-click (<control>+click), then choose
[Copy].

Pasting characters

Move the cursor to the copy destination, right-click (<control>+click), then
choose [Paste].

Copying a channel

Right-click (<control>+click) a copy source channel, then choose [Copy].

Pasting a channel

Right-click (<control>+click) the copy destination channel, then choose
[Paste].

Resetting to the default value (Ctrl (

Index

The following table describes how to use the Copy & Paste function.
Copying characters

) + click)

Move the cursor to a control or a parameter value, then hold down the <Ctrl> key ( ) and click
the mouse button to reset the value to the default (e.g., to reset an Input Channel fader to –∞, or
reset a pan setting to Center).

Ctrl(

)+Shift+Click
Move the cursor to a fader or AUX Send control, then hold down the <Ctrl> key ([ ]) and
<Shift> key and click the mouse button to reset the value to the nominal level.
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The Master window enables you to switch between layers and control Stereo Out signals. To open this window, choose [Master] from the [Windows] menu.

A [ONLINE]/[OFF LINE] button
Repeatedly clicking this button toggles between online and offline status.
Note: If Studio Manager is not connected or is not communicating with the 02R96,
clicking this button will not switch the unit from offline to online.
This indicator is displayed when Studio Manager is connected to
the 02R96 correctly. If the connection is correct, the Studio Manager parameters will work in unison with the 02R96 parameters.
This indicator is displayed when Studio Manager is not connected or
is not communicating with the 02R96, or when you have selected
Offline Edit. If the connection is incomplete, the Studio Manager
parameters will not work in unison with the 02R96 parameters.

2

B Meters

3

These meters display the output level of the
Stereo Out when Surround mode is set to
“STEREO,” or the Bus Outs used for surround processing when Surround mode is
set to 3-1, 5.1 or 6.1. The meters in 3-1, 5.1
and 6.1 Surround modes are shown on the
right.

4
5
6
7
8

Index

C LAYER buttons
These buttons are used to select the Layers.

D PAN CONTROL
3-1
5.1
6.1
These buttons are used to select either
“STEREO” (Stereo mode) or “SURR” (Surround mode). The Pan control on the Input
Channels is a rotary control when “STEREO” is selected, and a dot on a pan
graph when “SURR” is selected.

E Scene number display
This display indicates the currently-recalled scene’s number.

F [AUTO] button
This button displays the Automix status of the Stereo Out.

9

G [SELECT] button
This button is used to select the Stereo Out.

H [ON] button
This button turns the Stereo Out on and off. It appears orange while the Stereo
Out is on.

I Master fader
This is the Stereo Out fader.

J

J Fader value indicator
This indicator indicates the fader position in decibels (dB).
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Input Channels
A

Selecting the 1-24, 25-48, or MASTER LAYER button in the Master window displays the
corresponding Input Channel strips.

B

A SOURCE parameter

L
M
N
O

This parameter is used to select an Input source. To select an Input source, click the
parameter and choose from the list that appears.

B Routing buttons
These buttons are used to route the Input Channel to the Bus Outs.

C [STEREO] button
This button is used to route the Input Channel’s signal to the Stereo Out.

D [DIRECT] button
This button turns on and off the Input Channel’s routing to its Direct Out.

E Direct Out parameter
This parameter is used to select the Direct Out destination. To select a destination,
click the parameter and choose from the list that appears.

F [PHASE] button

Index

C
D
E
F
G
H
I
J
K

Getting Started

Note:
• You can selectively turn on or off some of channel strips by using the [View] menu.
• You can open multiple Layer windows. The second and subsequent open windows will indicate
“Locked” in the title, which means that these windows do not reflect layer selections made on the console
or in the Master window. If you want the Layer windows to reflect the changes, right-click each window
(Macintosh: <control> + click), then select the desired layer using the LAYER buttons.
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The 02R96 Editor’s Layer window displays 24 channel strips. You can select a layer using the LAYER
buttons in the Master window. To open the Layer window, choose [Layer] from the [Windows] menu.

Keyboard Shortcuts

Layer Windows

This button is used to reverse the signal phase of the channel.

G [INSERT] button
This button is used to turn on and off the Input Channel’s Insert.

H [GATE] button
This button is used to turn on and off the Input Channel’s Gate.

I Gate open/close indicators
These indicators display whether the Gate is open (green) or closed (red).

J Gate threshold
This displays the Gate Threshold, which can be set by dragging.

K [COMP] button
This button is used to turn on and off the Input Channel’s Compressor.

L Compressor curve
This display shows the Compressor’s curve.

M [EQ] button
This button is used to turn on and off the Input Channel’s EQ.

N EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

O [DELAY] button
This button is used to turn on and off the Input Channel’s Delay function.

P Delay parameter
This parameter is used to set the delay time of the Delay function. Delay times can be
set by dragging.

Studio Manager for V2 02R96 Editor—Owner’s Manual
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R AUX section

R
S
T
V
W
X
Y
Z

On or off but no level set

Dark blue bar

Off, pre-fader

Green bar outline displays level

On, pre-fader

Green bar displays level

Off, post-fader

Orange bar outline displays level

On, post-fader

Orange bar displays level

S Pan/Aux Send display
This display shows the stereo or surround pan position or, while setting an Aux Send,
the Aux Send level in dB.

T PAN control
This control is used to set the Input Channel’s stereo or surround pan position.
When the PAN CONTROL in the Master Window is set to “STEREO,” the Pan control appears as a rotary control, and when set to “SURR,” the control appears as dot
on a pan graph. The surround pan position can be set by dragging the dot.

U LFE control

Index

P
Q

Appearance

When 5.1 or 6.1 Surround mode is selected, this control is used to set the
surround LFE Channel level. It appears when the PAN CONTROL in the
Master Window is set to “SURR.” To set the Channel level, drag the end of
its bar or click a point along the length of the bar.

V [AUTO] button

U

This button displays the Automix status of the Input Channel.

a

W [SELECT] button
This button is used to select the Input Channel.

X [SOLO] button
This button solos the Input Channel. It appears orange while the channel is soloed.

Y [ON] button
b

This button turns the Input Channel on and off. It appears orange while the channel
is on.

Z Short channel name
This is the channel’s short name. To edit the name, click it and type.

a Channel fader and channel meter
This is the Input Channel fader. The channel meter to the right of the fader displays
the Input Channel signal level.
b Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).
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These controls are used to set the levels of the Aux Sends. To set an Aux
Send level, drag its bar or click a point along the length of the bar. To turn
an Aux Send on or off, click its number.
The following table shows how the Aux Send controls appear depending
on the Aux Send On/Off and Pre/Post settings. Aux Sends can be set to
pre-fader or post-fader on the Selected Channel window (see “AUX
SEND section” on page 15).

Getting Started

Q Channel number
This is the channel number. Double-click the channel number to open the Selected
Channel window.
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When you select the Master LAYER button in the Master window, the Bus Out and
Aux Send channels are displayed. The Aux Send channel appears the same as the Bus
Out channels except that the Bus Out channels feature a [STEREO] button.

A

A [STEREO] button (Bus Out only)
This button is used to route the Bus Out to the Stereo Out.

Getting Started

Output Channels

B [INSERT] button
Using
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This button is used to turn on and off the Bus Out’s Insert.

C [COMP] button
C
D
E
F
G
H
I

This button is used to turn on and off the Bus Out’s Compressor.

D Compressor curve
This display shows the Compressor’s curve.

E [EQ] button
This button is used to turn on and off the Bus Out’s EQ.

F EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

G [DELAY] button
This button is used to turn on and off the Bus Out’s Delay function.

H Delay parameter
This parameter is used to set the delay time of the Delay function. Delay times
can be set by dragging.

I Channel number
This is the channel number. Double-click the channel number to open the
Selected Channel window.

J [AUTO] button
Index

J
K
L
M
N

This button displays the Automix status of the Bus Out.

K [SELECT] button
This button is used to select the Bus Out.

L [SOLO] button
This button solos the Bus Out. It appears orange while the Bus Out is soloed.

M [ON] button
O

This button turns the Bus Out on and off. It appears orange while the Bus Out is
on.

N Short channel name
This is the channel’s short name. To edit the name, click it and type.

O Channel fader and channel meter
This is the Bus Out fader. The meter to the right of the fader displays the Bus Out
signal level.

P

Keyboard Shortcuts

B

P Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).
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When you select the REMOTE LAYER button in the Master window, Remote Channels are displayed.

A Channel number
This is the channel number. Double-click the channel number to open the
Selected Channel window.

Getting Started

Remote Channels

This button is used to select the Remote Channel.

C [ON] button
This button turns the Remote Channel on and off. It appears orange while the
channel is on.
Note: When the remote target setting on the 02R96 is set to User Defined, you can
use the [ON] buttons and channel faders to control the functions specified on the
Remote page.

Using
UsingStudio
SM Windows
Manager
Windows

B [SELECT] button

A

This name indicates the remote target assigned on the 02R96.

E Channel fader
This is the Bus Out’s fader.
Note: When the remote target setting on the 02R96 is set to User Defined, you can
use the [ON] buttons and channel faders to control the functions specified on the
Remote page.

Keyboard Shortcuts

D Remote target name

F Fader value indicator

B
C
D

If the remote target is set to User Assignable Layer:
In this case, the assigned channels are displayed. For more information, refer to
“Input Channels” on page 10 and “Output Channels” on page 12. If the Group Master Fader is assigned, only the [AUTO], [SOLO], and [ON] buttons and channel faders are displayed.

E

F
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This indicator indicates the fader position in the range of 0 through 127.

Keyboard Shortcuts

Note: You can open multiple Selected Channel windows. The second and subsequent open
windows will indicate “Locked” in the title, which means that you cannot open Library
windows from these windows. In addition, these windows will not reflect the following
edits:
• Channel selections made in the Layer window (via the SELECT button)
• Edits in the Surround Editor window

Input Channels
C

D

E

F

Index

A B

Getting Started

The Selected Channel window allows detailed editing of the currently selected channel. To open the
Selected Channel window, choose [Selected Channel] from the [Windows] menu.
There are five variations of the layout of the Selected Channel window, as follows:
• Input Channels (see below)
• Bus Outs (see page 16)
• Aux Sends (see page 17)
• Stereo Outs (see page 18)
• Remote Channels (see page 19)
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Selected Channel Window

G H

I

A CHANNEL SELECT, INPUT PATCH & LIBRARY section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. To edit the name, click it and type. The INPUT PATCH parameter is used to select an input
source. To select an input, click the parameter and choose from the list that appears. The [LIBRARY]
button opens the Channel Library window.

B GATE section
This section contains the Gate controls and display graph for the currently selected Input Channel.
The rotary controls are used to set the threshold, range, attack, decay, and hold. The GR meter indicates the amount of gain reduction being applied by the Gate. The [ON] button turns the Gate on and
off. The [LINK] button links the Gate of the currently selected Input Channel with the Gate of its partner channel. The KEY IN parameter is used to select a Gate trigger source. The [LIBRARY] button
opens the Gate Library window.
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E ROUTING, PAN & level section
This section contains the routing, pan, and level controls and the [AUTO], [SOLO], and [ON] buttons
for the currently selected Input Channel. ROUTING buttons 1–8 are used to route the channel to the
Bus Outs. The [STEREO] button routes the channel to the Stereo Out. The [DIRECT] button routes
the channel to its Direct Out, and the Direct Out parameter below it selects a Direct Out destination.
The [F.PAN] button turns on and off the Bus Out Follow Pan function. The PAN control is used to
pan the channel. The [AUTO] button displays the Automix status. The [SOLO] button is used to solo
the channel, the [ON] button, to turn on and off the channel, and the channel fader, to set the channel
level. The meter to the right of the fader indicates the signal level, and the value indicator under the
fader indicates the fader position in decibels (dB).

F AUX SEND section
This section contains the Aux Send controls for the currently selected Input Channel. Use the rotary
controls to set the Aux Send levels, and click them to turn Aux Sends on and off. Use the button below
each Aux Send control to select pre-fader or post-fader. In Fixed mode, this button is used to turn Aux
Sends on and off (the level is fixed at nominal).
When Aux Sends are paired, a heart icon is displayed between them, and the odd-numbered Aux Send
control sets the level, while the even-numbered control works as a pan control.

G INSERT section
This section contains the Insert parameters for the currently selected Input Channel. The [ON] button
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert
in the signal path.

H COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Input
Channel. The rotary controls are used to set the threshold, ratio, attack, release, gain, and knee. The
GR meter indicates the amount of gain reduction being applied by the Compressor. The OUT meter
indicates its output level. The [ON] button turns the Compressor on and off. The [LINK] button links
the Compressor of the currently selected Input Channel with the Compressor of its partner channel.
The POSITION parameter is used to specify the position of the Compressor in the signal path. The
ORDER parameter is used to specify the order of the Compressor and Insert when both are inserted
at the same position. The [LIBRARY] button opens the Compressor Library window.

I PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected
Input Channel. Click the heart icon to pair and unpair the channel with its partner channel.
Use the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.
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This section contains the delay and phase controls for the currently selected Input Channel. The rotary
controls are used to set the delay time, feedback gain, and mix balance (wet/dry balance). The [ON]
button turns the Delay on and off. The [PHASE] button reverses the channel’s signal phase.

Keyboard Shortcuts

D DELAY & PHASE section

Index

This section contains the EQ controls and display graph for the currently selected Input Channel. The
rotary controls are used to set the gain, center frequency, and Q of each band, and the pre-EQ attenuation
level. EQ can also be set by dragging the EQ curve on the EQUALIZER graph. The [ON] button turns the
EQ on and off. The TYPE buttons select the EQ type. The [LIBRARY] button opens the Equalizer Library
window.

Getting Started

C EQUALIZER section

B

C

D

E F

G

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. The [LIBRARY] button opens the Channel Library window.

Keyboard Shortcuts

Using
UsingStudio
SM Windows
Manager
Windows

A

Getting Started

Bus Outs

This section contains the EQ controls and display graph for the currently selected Bus Out. It’s layout
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for
more information.

C DELAY section
This section contains the delay controls for the currently selected Bus Out. The rotary control is used
to set the delay time, and the [ON] button turns the Delay function on and off.

D TO STEREO & level section
This section contains the TO STEREO, pan and level controls and the [AUTO], [SOLO], and [ON] buttons for the currently selected Bus Out. The TO STEREO button routes the Bus Out to the Stereo Out,
and the rotary controls are used to set the Bus to Stereo send level and pan. The [AUTO] button displays
the Automix status. The [SOLO] button is used to solo the Bus Out, the [ON] button, to turn the Bus
Out on and off, and the channel fader, to set the Bus Out level. The meter to the right of the fader indicates the signal level, and the value indicator under the fader indicates the fader position in dB.

E INSERT section
This section contains the Insert parameters for the currently selected Bus Out. The [ON] button turns
the Insert on and off. The OUT and IN parameters are used to select the insert out destination and
insert in source respectively. The POSITION parameter is used to specify the position of the Insert in
the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Bus Out.
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section”
on page 15 for more information.

G PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected
Bus Out. Click the heart icon to pair and unpair the channel with its partner channel. Use
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.
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Index

B EQUALIZER section

B

C

D

E F

G

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. The [LIBRARY] button opens the Channel Library window.

Keyboard Shortcuts

Using
UsingStudio
SM Windows
Manager
Windows

A

Getting Started

Aux Sends

This section contains the EQ controls and display graph for the currently selected Aux Send. It’s layout
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for
more information.

C DELAY section
This section contains the delay controls for the currently selected Aux Send. The rotary control is used
to set the delay time, and the [ON] button turns the Delay function on and off.

D Aux Send level section
This section contains the [AUTO], [SOLO], and [ON] buttons and the channel fader for the currently
selected Aux Send. The meter to the right of the fader indicates the signal level, and the value indicator
under the fader indicates the fader position in decibels (dB).

E INSERT section
This section contains the Insert parameters for the currently selected Aux Send. The [ON] button
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert
in the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Aux Send.
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section”
on page 15 for more information.

G PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected
Aux Send. Click the heart icon to pair and unpair the channel with its partner channel. Use
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.
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Index

B EQUALIZER section

B
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D

E F

G

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. The [LIBRARY] button opens the Channel Library window.

Keyboard Shortcuts

Using
UsingStudio
SM Windows
Manager
Windows

A

Getting Started

Stereo Out

This section contains the EQ controls and display graph for the Stereo Out. It’s layout is identical to
the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for more information.

C DELAY section
This section contains the delay controls for the Stereo Out. The rotary control is used to set the delay
time, and the [ON] button turns the Delay function on and off.

D Balance & level section
This section contains the balance control, [AUTO] and [ON], and channel fader for the Stereo Out.
The meter to the right of the fader indicates the signal level, and the value indicator under the fader
indicates the fader position in decibels (dB).

E INSERT section
This section contains the Insert parameters for the Stereo Out. The [ON] button turns the Insert on
and off. The OUT and IN parameters are used to specify the insert out destination and insert in source
respectively. The POSITION parameter is used to specify the position of the Insert in the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Stereo Out.
Its layout is identical to the COMPRESSOR section for Input Channels except there is no [LINK] button. See “COMPRESSOR section” on page 15 for more information.

G FADER GROUP & MUTE GROUP section
This section contains the Fader and Mute group functions for the Stereo Out. Use the FADER GROUP
buttons to add the Stereo Out to Fader groups, and use the MUTE GROUP buttons to add it to Mute
groups.
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Index

B EQUALIZER section

Library page

Action

Channel Library
Gate Library

[LIBRARY] buttons on the Selected Channel window

Compressor Library
Equalizer Library
Input Patch Library
Output Patch Library
Effect Library

[LIBRARY] button on the Patch Editor window
[LIBRARY] buttons on the Effect Editor window

The layout of the Library window pages is the same regardless of which page is selected (the Scene
Memory library is shown below). The Library window consists of two panes. The pane on the left,
called the [FILE] section, displays the status of the currently open library file. The pane on the right,
called the [INTERNAL DATA] section, displays the status of the corresponding library in the console.
You can copy and sort the items in the list (memories) by dragging them between the panes. Within
the same pane, you can copy a memory by dropping it on top of another memory, and you can sort
memories by dropping a memory between two memories. Memory contents can be swapped by holding down the <Shift> key while dragging. In all cases, the contents of the destination memory are
overwritten. To edit a memory title, click the title, then type.

ABC D E

J
K

N
O
P
F

L G H I

M
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Using
UsingStudio
SM Windows
Manager
Windows

The Library window enables you to control and manage Scenes and libraries. In addition, Scenes and
libraries can be saved to disk on your computer as Library files.
To open the Library window, choose [Library] from the [Windows] menu. The Library window consists of 9 display pages. You can access each of these pages by clicking the tabs along the top of the window, or by following the action described below:

Keyboard Shortcuts

Library Window

Index

If the remote target is set to User Assignable Layer, the assigned channels are displayed. For more information, refer to “Input Channels” on page 10 and “Output Channels” on page 12. If the Group Master
Fader is assigned, only the [AUTO], [SOLO], and [ON] buttons and channel faders are displayed.

Getting Started

Remote Channels

B [OPEN] button
This button is used to open Library files.
Note: Studio Manager may be unable to open some files stored in SmartMedia. In this case, copy those
files onto a hard disk, then try to open them in Studio Manager.

Getting Started

A File name
This is the file name of the currently open Library file.

C [CLOSE] button
Using
UsingStudio
SM Windows
Manager
Windows

This button is used to close the currently open Library file.

D [SAVE] button
This button is used to save the currently open Library file.

E [SAVE AS] button
This button is used to save the currently open Library file with a different name.

F TITLE
This column displays the memory titles.
This column displays padlock icons for protected memories. It also displays an “ ” (read-only) icon
for preset data.

H INPUT PATCH LINK (only for Scene memories)
This column displays the input patch memory numbers linked to the Scene library. When you store
or recall a Scene memory, the linked Input Patch Library memory is stored or recalled at the same
time.

I OUTPUT PATCH LINK (only for Scene memories)

Keyboard Shortcuts

G PROTECT (only for Scene memories and Automix memories)

This column displays the Output Patch memory numbers linked to the Scene library. When you store
or recall a Scene memory, the linked Output Patch Library memory is stored or recalled at the same
time.
Index

J [STORE] button
This button is used to store the contents of the library to the specified location.
Note: You cannot store Automix memories during offline editing.

K [RECALL] button
This button is used to recall the selected memory.
Note: You cannot recall Automix memories during offline editing.

L [FILE] section
This section displays the contents of the currently open library file.

M [INTERNAL DATA] section
This section displays the console’s status of the currently selected library.
Note: If the OFFLINE indicator is selected by the [ONLINE]/[OFFLINE] button in the Master window,
Studio Manager is not synchronizing with the console. Therefore, this section does not display the console’s
correct status.

N [CLEAR] button
This button clears the selected memory from the list.

O [UNDO] button
This button undoes the last recall, store, copy, clear, sort or titling operation.
Note: In the Library window, you can undo only the most recent operation. You cannot undo any operations performed prior to the most recent operation.

P [PROTECT] button (only for Scene memories and Automix memories)
This button is used to protect or unprotect the selected memory.
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The Patch Editor window is used to patch Inputs, Outputs, Inserts, Effects, and Direct Outs. To open
this window, choose [Patch Editor] from the [Windows] menu. This window consists of five pages,
which you can select by clicking the tabs along the top of the window.

INPUT PATCH Page
B

C

D

E

Using
UsingStudio
SM Windows
Manager
Windows

A

Getting Started

Patch Editor Window

Keyboard Shortcuts

F

Index

G

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

D [ALL CLEAR] button
This button clears all patches on this page.

E [LIBRARY] button
This button opens the Input Patch Library window.

F Port names
These are the Port names. To edit a name, click it and type.

G Patchbay
The patchbay is used to patch input ports to Input Channels. Active patches are indicated by a blue
dot. To make a patch, click a square. To unpatch, click a blue dot.
Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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A

B

C

D

Getting Started

OUTPUT PATCH Page
E

Using
UsingStudio
SM Windows
Manager
Windows

F

Keyboard Shortcuts

G

A Channel IDs
These are the Channel IDs.

B Long channel names
Index

These are the Channel long names. To edit a name, click it and type.

C [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

D [ALL CLEAR] button
This button clears all patches on this page.

E [LIBRARY] button
This button opens the Output Patch Library window.

F Port names
These are the Port names. To edit a name, click it and type.

G Patchbay
The patchbay enables you to patch output ports to Output Channels. Active patches are indicated by
a red dot. To make a patch, click a square. To unpatch, click a red dot.
Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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B

C

Using
UsingStudio
SM Windows
Manager
Windows

A

Getting Started

INSERT PATCH Page

E

Keyboard Shortcuts

D

F

Index

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [LIBRARY] buttons
These buttons open the Input and Output Patch Library windows.

D Port names
These are the Port names. To edit a name, click it and type.

E Insert Out Patchbay
This patchbay is used to patch output ports to the Insert Outs of Input Channels, Bus Outs, Aux Sends,
and the Stereo Out. Active patches are indicated by a red dot. To make a patch, click a square. To
unpatch, click a red dot.

F Insert In Patchbay
This patchbay is used to patch input ports to the Insert Ins of Input Channels, Bus Outs, Aux Sends,
and the Stereo Out. Active patches are indicated by a blue dot. To make a patch, click a square. To
unpatch, click a blue dot.
Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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Keyboard Shortcuts

Using
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Manager
Windows

A

Getting Started

EFFECT PATCH Page

C

Index

A Effects processor 1 section
This section indicates the effects name assigned to internal Effects processor 1. The parameters in this
section are used to select inputs and outputs for Effects processor 1.

B [LIBRARY] button
This button opens the Input Patch Library window.

C Effects processors 2–4 section
This section indicates the effects names assigned to internal Effects processors 2–4. The parameters in
this section are used to select inputs and outputs for Effects processors 2–4.
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B

C

Using
UsingStudio
SM Windows
Manager
Windows

A

Getting Started

DIRECT OUT PATCH Page

D

Keyboard Shortcuts

E

Index

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [LIBRARY] button
This button opens the Output Patch Library window.

D Port names
These are the Port names. To edit a name, click it and type.

E Patchbay
The patchbay is used to patch output ports to the Direct Outs. Active patches are indicated by a red
dot. To make a patch, click a square. To unpatch, click a red dot.
Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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The Surround Editor window enables you to edit the surround pan position of the currently selected
Input Channel. To open the Surround Editor window, choose [Surround Editor] from the [Windows]menu.

A

B
E

F
G
C

H

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Channel ID. To edit the name, click it and type.

Keyboard Shortcuts

Using
UsingStudio
SM Windows
Manager
Windows

D

Getting Started

Surround Editor Window

The green dot on this graph indicates the surround pan position for the currently selected Input Channel. The surround pan can be set by dragging the dot. Clicking a speaker icon will move the pan position to the position of that icon.

C Surround pan position
This is the current surround pan position.

D SURROUND MODE parameter
Click this parameter to display the option list and set Surround mode to STEREO, 3-1, 5.1, or 6.1.

E [LFE] control
This rotary control sets the level of the LFE channel.

F [DIV.F] control (6.1)/[DIV] control (3-1, 5.1)
This rotary control sets the amount of divergence (i.e., how the Center signal is fed to the Left, Right,
and Center channels). With 6.1 surround, you can set the divergence for both the front and rear. The
[DIV.F] control sets the amount of divergence for the front signal.

G [DIV.R] control (6.1 only)
This rotary control sets the amount of divergence for the rear signal.

H [LINK] button (6.1 only)
This button is used to link the [DIV.F] and [DIV.R] controls.
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Index

B Surround pan graph

hour

minute

second

frame

measure

beat

MIDI clock

Effect Editor Window
The Effect Editor window enables you to edit the internal effects processors. To open the Effect Editor
window, choose [Effect Editor] from the [Windows] menu.
Note: You can open multiple Effect Editor windows. The second and subsequent open windows will indicate “Locked” in the title, which means that you cannot open Library windows from these windows.
Note: When you recall effects, windows that do not indicate “Locked” in the title will be recalled.

B

3 4 5

Getting Started
Index

A

Using
UsingStudio
SM Windows
Manager
Windows

The Timecode Counter window displays the current timecode position in hours, minutes, seconds,
and frames — or measures, beats, and MIDI clocks — depending on the specified timecode source. It
works in unison with the timecode counters on the 02R96 Automix Main page.
To open the Timecode Counter window, choose [Timecode Counter] from the [Windows] menu.

Keyboard Shortcuts

Timecode Counter Window

F

G H

A Effects processor select
These buttons are used to select the internal effects processors.

B Effect select section
The EFFECT NAME, TYPE, and IN/OUT are the name, type and I/O configuration of the effect
recalled to the currently selected effects processor. To edit the EFFECT NAME, click it and type. The
[LIBRARY] button opens the Effects Library window.

C [IN] button
This button is used to set the metering position to the effects processor’s inputs.

D [OUT] button
This button is used to set the metering position to the effects processor’s outputs.

E Meters
These are output meters for the currently selected effects processor.
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This section contains the various effects controls, buttons, and displays. Its layout depends on the
selected effect type.

G [MIX BALANCE] control
This control enables you to adjust the balance between the wet and dry signals. When set to 0, only the
dry signal is heard. When set to 100, only the wet signal is heard.

Getting Started

F Effect parameter section

H [BYPASS] button

The Meter window displays the Input, Output, Effect, and Stereo Out meters. To open the Meter window, choose [Meter] from the [Windows] menu. This window consists of four display pages. You can
access these pages by clicking the tabs along the top of the window.
Page

Function

CH1-56 page

This page displays the Input Channel CH1-56 meters (12 segments).

MASTER page

This page displays the Bus 1-8, Aux 1-8, and Stereo meters (12 segments).

Effects 1-4 page

This page displays the Channel 1 & 2 input/output meters (12 segments) for Effects
1-4.

Stereo page

This page displays a bar graph (32 segments) of signal levels output to the Stereo Out.

The layout of the Meter window pages is the same regardless of the page selected. (The Master page is
shown below.)

2

3

Index

A

Keyboard Shortcuts

Meter Window

Using
UsingStudio
SM Windows
Manager
Windows

This button is used to bypass the currently selected effects processor.

A Meter mode
You can select the type of meters to be displayed from the following options:
GATE GR: The meters indicate the amount of gain reduction being applied by the channel Gate.
COMP GR: The meters indicate the amount of gain reduction being applied by the channel
Compressor.
LEVEL:
The meters indicate the channel level.

B POSITION parameter
This parameter, available only when Meter mode is set to Level, enables you to select the metering
position in the signal path.

C PEAK HOLD button
This button turns the Peak Hold function on and off.
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Windows menu

Library window

Macintosh

Creates a new Session

Ctrl+N

+N

Opens a previously saved Session

Ctrl+O

+O

Saves the current Session

Ctrl+S

+S

Undo

Ctrl+Z

+Z

Redo

Ctrl+Y

+Y

Closes the active window

Ctrl+W

+W

Closes all windows

Ctrl+Alt+W

+Option+W

Opens the Master window

Ctrl+1

+1

Opens the Layer window

Ctrl+2

+2

Opens the Selected Channel window

Ctrl+3

+3

Opens the Library window

Ctrl+4

+4

Opens the Patch Editor window

Ctrl+5

+5

Opens the Surround Editor window

Ctrl+6

+6

Opens the Timecode Counter window

Ctrl+7

+7

Opens the Effect Editor window

Ctrl+8

+8

Opens the Meter window

Ctrl+9

Selects consecutive multiple items (memories)

Shift+click

shift+click

Selects non-consecutive multiple items (memories)

Ctrl+click

control+click

Selects all memories in a section

Ctrl+A

control+A

Using
UsingStudio
SM Windows
Manager
Windows

Edit menu

Windows

+9

Index

File menu

Action

Keyboard Shortcuts

Menu

Getting Started

Keyboard Shortcuts
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A
ALL CLEAR button ................ 21, 22
All Lib ............................................... 6
AUTO button ...................... 9, 11, 12
AUTO SETUP button ............ 21, 22
Aux Section .................................... 11
Aux Send level section .................. 17
AUX SEND section ....................... 15
Aux Sends ...................................... 17

B
Balance & level section .................. 18
Bus Outs ......................................... 16
BYPASS button ............................. 28

C
CH1-56 page .................................. 28
Channel Copy Parameter ............... 5
Channel fader .................... 11, 12, 13
Channel IDs ................. 21, 22, 23, 25
Channel Library ............................ 19
channel meter .......................... 11, 12
Channel number ............... 11, 12, 13
Channel Select ................................. 4
CHANNEL SELECT section
.................. 14, 16, 17, 18, 26
CLEAR button ............................... 20
CLOSE button ............................... 20
COMP button ......................... 10, 12
Compressor curve ................... 10, 12
Compressor Library ...................... 19
COMPRESSOR section
........................ 15, 16, 17, 18
Configuring the Editor ................... 4
Confirmation ................................... 4
Console Device ID .......................... 4
Console Setup .................................. 5
Console->PC ................................... 4
Copy ................................................. 8
Creating a new Session ................... 7
Ctrl + click ....................................... 8
Ctrl + Shift + Click .......................... 8

D
DELAY & PHASE section ............ 15
DELAY button ......................... 10, 12

E
Effect editor window .................... 27
Effect Library ................................. 19
EFFECT NAME ............................ 27
Effect parameter section ............... 28
Effect patch page ........................... 24
EFFECT TYPE .............................. 27
Effects 1-4 page ............................. 28
Effects processor 1 section ........... 24
Effects processor select ................. 27
Effects processors 2-4 section ...... 24
EQ button .................................10, 12
EQ curve ...................................10, 12
Equalizer Library .......................... 19
EQUALIZER section ...15, 16, 17, 18
Exiting Studio Manager ................. 3
extension ......................................... 7

F
FADER GROUP buttons
.........................15, 16, 17, 18
FADER GROUP section
.........................15, 16, 17, 18
Fader value indicator .....9, 11, 12, 13
File name ....................................... 20
FILE section ................................... 20
From Hardware .............................. 6

G
GATE button ................................ 10
Gate Library .................................. 19
Gate open/close indicators ........... 10
GATE section ................................ 14
Gate threshold ............................... 10
Group Master Fader ..................... 13

H
host window .................................... 3

IN button .......................................27
Index ...............................................30
Input Channels ........................10, 14
Input Patch Library .......................19
INPUT PATCH LINK ..................20
Input patch page ............................21
INPUT PATCH section ................14
Input Port/Output Port ..................4
INSERT button ........................10, 12
Insert In Patchbay .........................23
Insert Out Patchbay ......................23
Insert patch page ...........................23
INSERT section ........... 15, 16, 17, 18
INTERNAL DATA section ...........20

K
Keyboard shortcuts .......................29

L
Launching Studio Manager ............2
LAYER button ................... 10, 12, 13
LAYER buttons ................................9
Layer Select ......................................4
Layer Windows ..............................10
level section ....................................15
LFE control ..............................11, 26
Library
Channel ....................................19
Compressor ..............................19
Effect .........................................19
Equalizer ...................................19
Gate ...........................................19
Input Patch ..............................19
Output Patch ...........................19
LIBRARY button
............ 16, 21, 22, 23, 24, 25
LIBRARY section ...........................14
Library Window ............................19
LINK button (6.1 only) ................26
Long channel names ... 21, 22, 23, 25

M
Master fader .....................................9
MASTER page ...............................28
Master Window ...............................9
Meter mode ...................................28
Meter Window ..............................28
Meters ......................................... 9, 27
MIDI port ........................................2
MIX BALANCE control ...............28
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Getting Started

I

Using
UsingStudio
SM Windows
Manager
Windows

1-24 button .................................... 10
25-48 button .................................. 10

Delay parameter .......................10, 12
DELAY section ...................16, 17, 18
Device Editor section ...................... 2
DIRECT button ............................ 10
Direct Out parameter ................... 10
Direct out patch page ................... 25
DIV.F control/DIV control .......... 26
DIV.R control (6.1 only) .............. 26
dry signal ....................................... 28

Keyboard Shortcuts

Numerics

Index

Index

P
Pair icon ............................. 15, 16, 17
PAN CONTROL ............................. 9
PAN control .................................. 11
PAN section ................................... 15
Pan/Aux Send display ................... 11
Paste ................................................. 8
Patch editor window ..................... 21
Patchbay ............................. 21, 22, 25
PC->Console ................................... 4
PEAK HOLD button .................... 28
PHASE button ............................... 10
Port names ................... 21, 22, 23, 25
POSITION parameter .................. 28
PROTECT ...................................... 20
protect any communication ports . 6
PROTECT button ......................... 20

Q

Y
Y56K card .........................................7
Yamaha Web Site ............................1

Timecode counter window .......... 27
TITLE ............................................. 20
To Hardware ................................... 6
TO STEREO section ..................... 16
Total Recall ...................................... 6

U
Undo ................................................ 7
UNDO button ............................... 20
User Assignable Layer ................... 13
User Defined ................................. 13

V
RECALL button ............................ 20
Redo ................................................. 7
Remote Channels .................... 13, 19
Remote target name ...................... 13
Re-synchronize ................................ 6
Resynchronizing Studio Manager
............................................ 6
ROUTING buttons ....................... 10
ROUTING section ........................ 15
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T

Quitting Studio Manager ............... 3

R

Using
UsingStudio
SM Windows
Manager
Windows

Offline .............................................. 9
Offline Edit .................................. 6, 9
Offline indicator .............................. 2
ON button ............... 9, 11, 12, 13, 16
Online indicator .............................. 2
ONLINE/OFF LINE button ........... 9
OPEN button ................................ 20
Opening a previously saved Session
............................................ 7
OUT button ................................... 27
Output channels ............................ 12
Output Patch Library .................... 19
OUTPUT PATCH LINK .............. 20
Output patch page ........................ 22

SAVE AS button ........................... 20
SAVE button ................................. 20
Saving the current Session ............. 7
Saving the current Session with a new
name ................................. 7
Scene number display ..................... 9
SELECT button ..............9, 11, 12, 13
Selected Channel Window ........... 14
Setup window ................................. 4
Short channel name .................11, 12
Shortcuts, keyboard ...................... 29
SOLO button ...........................11, 12
SOURCE parameter ..................... 10
Starting Studio Manager ................ 2
STEREO button .......................10, 12
Stereo Out ..................................... 18
Stereo page .................................... 28
STORE button .............................. 20
Surround editor window ............. 26
Surround mode parameter .......... 26
Surround pan graph ..................... 26
Surround pan position ................. 26
Synchronization .............................. 6
Synchronize ..................................... 6
Synchronizing Studio Manager ..... 6
System Setup ................................... 4

Patch editor ..............................21
Selected Channel .....................14
Surround editor .......................26
Timecode counter ...................27
window .............................................9
Window Control from Console .....4
WindowEffect editor .....................27
Workspace section ..........................2
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